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PREFAZIONE

Il presente documento rientra nella convenzione quadro UNIUD-
AUSIR-GESTORI ‘Sostenibilita ed innovazione del Ciclo Idrico Integra-
to’ e in particolare nell’accordo attuativo AUSIR Sostenzbilita del Ciclo 1drico
Integrato e gestione efficiente del Servizio ldrico Integrato: reti, processi e residui.
L’accordo ha come scopo quello di promuovere lattivita di ricerca in
materia di gestione efficiente del servizio idrico integrato, dell'utilizzo
sostenibile delle risorse e di efficientamento dei sistemi di gestione degli
impianti. In questa cornice si inseriscono i quaderni AUSIR, documenti
atti a standardizzare metodi e procedure di analisi delle diverse sezioni
che compongono il Servizio Idrico Integrato.

Il volume B1 propone una serie di linee guida per una corretta gestione
dei modelli di simulazione dei sistemi acquedottistici in ambiente EPA-
NET, analizzando in particolare i processi di realizzazione, calibrazione e
aggiornamento dei modelli.

La prima parte del volume contiene delle indicazioni che possano guidare
gli Enti Gestori nella realizzazione di modelli di dettaglio partendo da dati
geo-riferiti, qualora vi fossero ancora alcuni sistemi acquedottistici da loro
gestiti di cui non possiedano un modello di simulazione. Dopo aver ri-
portato I'elenco delle informazioni di partenza necessarie, si procede ana-
lizzando le sezioni principali che compongono i file di input di EPANET,
realizzabili attraverso un semplice foglio di calcolo. Infine, si presentano i
passaggi necessari a completare il modello attraverso EPANET stesso.
Nel secondo capitolo si riportano invece delle linee guida per il proces-
so di taratura dei modelli sulla base di misure in campo di portate e
pressioni. La calibrazione dei modelli viene spesso trascurata, svolta o
commissionata in maniera occasionale. Perché, pero, ci si possa ‘fidare’
maggiormente dei risultati forniti dai modelli ¢ essenziale che siano ben
tarati. Per questo, oltre a fornire in maniera chiara i passaggi fondamen-
tali del processo di calibrazione, si suggerisce anche una sua program-
mazione: ¢ grazie, infatti, a una pianificazione del processo di taratura
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che ¢ possibile impostare il modello nella maniera piu corretta ed otte-
nere un risultato di calibrazione ottimale.

La parte conclusiva del volume riguarda i modelli di simulazione che gli
Enti Gestori gia hanno a disposizione e si focalizza sull'importanza del
gestirne I'attendibilita. Perché un modello simuli correttamente il funzio-
namento di un sistema acquedottistico deve essere innanzitutto aggiorna-
to, ma l'aggiornamento dei modelli ¢ un’operazione anch’essa troppo
spesso trascurata, svolta in maniera saltuaria e parziale. Per questo motivo
nel presente volume verranno riportati gli step principali per un aggior-
namento sistematico dei modelli di simulazione. Questa parte vuole esse-
re una traccia per gli Enti Gestori da cui partire per sviluppare un proprio
iter interno di aggiornamento dei file di modellazione acquedottistica a
loro disposizione.



1. REALIZZAZIONE DI UN MODELLO EPANET

Il presente capitolo riporta la procedura che puo essere utilizzata per
creare un modello di simulazione EPANET a partire da dati geo-riferiti.

1.1. Dati di partenza e loro elaborazione attraverso QGIS
La procedura di seguito descritta si basa sull’utilizzo di dati geo-riferiti,
ovvero dati (vettoriali o raster) correlati alla loro posizione geografica.
I’associazione dato-posizione puo essere svolta e visualizzata attraverso
sistemi GIS con cui, inoltre, ¢ possibile elaborare i dati stessi, metterli in
relazione tra loro estrapolando cosi nuove informazioni.

1.1.1. Dati di partenza. La prima operazione consiste nell’assicurarsi che
tutti 1 dati di base necessari alla realizzazione del modello di simulazione
siano disponibili. Tali dati (in formato vettoriale shapefile) riguardano:

la rete acquedottistica, sia di adduzione che di distribuzione, in partico-
lare il suo tracciato planimetrico in opportuno sistema di riferimento e
le sue proprieta geometriche (lunghezze e DN) e fisiche (materiale o
relativo coefficiente di scabrezza);

le captazioni, con la loro posizione planimetrica e le loro quote di
progetto;

gli impianti di pressurizzazione e la loro posizione planimetrica;

1 serbatoi, con la loro posizione planimetrica, le loro caratteristiche
geometriche e le loro quote di progetto;

le valvole (PRV, PSV, ecc.), se presenti, e la loro posizione planime-
trica;

le valvole di distretto della rete (saracinesche chiuse che fisicamente
delimitano 1 distretti) e la loro posizione planimetrica;

1 punti di misura, punti in cui sono posizionati misuratori fissi di por-
tata ¢/o di pressione o punti predisposti alla collocazione di misurato-
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ri mobili ai fini della distrettualizzazione, con la loro posizione plani-
metrica;
* Taltimetria del sistema, attraverso il DTM in formato rastet.

1.1.2. Elaborazioni su QGIS. Aprendo gli shapefile e il raster del DTM con
QGIS, un’applicazione desktop GIS open source, si puo procedere
all’elaborazione dei dati.
11 vettore che deve essere maggiormente rielaborato ¢ quello riguardante
la rete acquedottistica. Se tra gli attributi del layer della rete, visualizzabili
cliccando il tasto destro del mouse sul vettore (Fig. 1.1), vi sono indicati
anche lo stato di servizio e/o la funzione, si applica un filtro per escludere
eventuali tronchi dismessi /o la cui funzione sia quella di allacci.
Dopodiché si crea un nuovo campo nella tabella degli attributi nel modo
seguente: si apre il calcolatore di campi (Fig. 1.2), si sceglie come titolare il
nuovo campo (ID) e si seleziona la funzione che numera progressivamente
gli elementi del vettore, ovvero la funzione $id del gruppo di funzioni Re-
cord (Fig. 1.3).
Successivamente, sulla barra dei menu, selezionando Vettore > Strumenti di
Geometria > Estrai vertici, si sceglie la rete come vettore di ingresso e si crea
automaticamente un nuovo layer, “Vertici’, composto dai punti che de-
scrivono lo sviluppo planimetrico dei tronchi della rete. Nella tabella degli
attributi di questo vettore bisogna aggiungere due nuovi campi per espli-
citare le coordinate dei suoi element, attraverso le funzioni $x e $y del
gruppo Geometria nel calcolatore di campi.

A questo punto si utilizza il Plugin AequilibraE, in particolare la funzione

Network Manipulation > Network Preparation che crea due nuovi layer (Fig.

1.4):

¢  ‘Nod?, il vettore contenente i nodi della rete, numerati automaticamente
nel campo ID della tabella degli attributi;

* ‘Link’, il vettore contenente 1 tronchi della rete, che eredita gli attributi
del layer della rete e a cui si aggiungono due campi in cui sono indicati
gli ID del nodo iniziale e del nodo finale.

I’operazione appena descritta puo portare alla creazione di nodi sovrap-

posti. Per eliminare i duplicati, selezionato il vettore ‘Nod?’, si utilizza il

Plugin MMQGIS e la sua funzione Modify > Delete Duplicate Geometries.

10
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Fig. 1.1. Opzioni sul Layers Panel, QGIS.

8 x

Layers Panel
¢ TV &E-HFAD

v [ [ Rete
[4]— Layer Rete

p Zoom sul layer
Aggiungi alla panoramica

1 Rimuovi
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Salva con nome...
Salva come file di definizione del layer...
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Mostra totale elementi
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»

Fig. 1.2. Tabella degli attributi, QGIS.
,E’,, Layer Rete :: Features total: 1865, filtered: 1865, selected: 0
/2B SENGTESP B BRE =
FID_ATTR LENGTH T_Rilievo Da_In% Apri il calcolatore di campi (Ctrl+1) i Sist_Acque
1 45.211172849... 20090101000... 20090101000... 293428
5.8226839200... 20090101000... 20090101000... 293428
19370101000... 293428

76668
76657

2
3

126.66976459...
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Fig. 1.3. Calcolatore di campi, QGIS.
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Fig. 1.4. Plugin Aequilibrals, QGIS.

¥ AequilibraE - Network Preparation ? X
Links layer
Network Layer /" Layer Rete >

Line layer name |Link

Nodes layer
(@ Create node layer (O use node layer

Node layer nam |N0di I

Node numbering start E‘
0% Close

Creati anche per i nodi i due campi x e y nella tabella degli attributi, si
procede con la definizione della loro altimetria. Per ottenere un campo
descrivente la posizione altimetrica dei nodi si impiega un ulteriore Plu-
gin, il Point Sampling Tool, che permette di generare un nuovo vettore e di
sceglierne 1 campi di definizione utilizzando anche campi appartenenti a
vettori differenti. Attivando dunque il raster del DTM ¢ possibile creare
un nuovo e definitivo layer ‘Nodi” in cui i campi di definizione da sce-
gliere sono:

* TID ele coordinate x e y del vettore dei nodi;

* la quota del layer DTM.

Infine, ¢ necessario realizzare un vettore in cui per ogni nodo vengono
indicati 1 tronchi associati con le rispettive caratteristiche. Tale operazione
¢ possibile selezionando Vettore > Strumenti di Geoprocessing > Intersegione e
scegliendo i vettori ‘Nodi’ e ‘Link’.

Per quanto riguarda gli altri vettori di partenza ¢ sufficiente corredarli dei
campi contenenti le coordinate x e y e la quota DTM dei loro elementi.

1.1.3. Vettori finali. I vettori finali da utilizzare nei passaggi successivi
sono: ‘Vertict’, ‘Nod?’, ‘Link’, ‘Intersezione’, ‘Pompe’, ‘Captazioni’, ‘Serba-
tol’, ‘Misuratori’.

Gli .shx riguardanti le valvole saranno presi in considerazione in maniera
‘indiretta’ successivamente.

13
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1.2. Creazione del file di input attraverso un foglio di calcolo

Si procede salvando i vettori ottenuti dall’elaborazione su QGIS in for-
mato MS Office Open XML spreadsheet (*.xlsx), leggibile con il pro-
gramma Excel del pacchetto Microsoft Office, raggruppandoli poi in un
unico file in cui ogni foglio di lavoro raccoglie le informazioni di ciascun
layer.

Nello stesso file .xlsx, in un nuovo foglio, si organizzano i dati secondo
I'impostazione tipica dei file .inp di EPANET di seguito descritta (Ross-
man, 2000). Una volta predisposti correttamente, tali dati saranno sempli-
cemente copiati da Excel a un file .txt che EPANET riconoscera come
file di input.

1.2.1. Input File Format. I file di input di EPANET sono file di testo or-
ganizzati in sezioni introdotte da una parola chiave racchiusa in parentesi
quadrate. Di seguito si riporta ad esempio un estratto di un file .txt orga-
nizzato per essere letto come file di input dal software di modellazione.

[TITLE]
20190315
[OPTIONS]
Units LPS

Headloss H-W

[JUNC-

;ID Elev Demand

Jooo1l 7.285 0.00761179

Jooo2 14.551 0.00000000

[RESER-

;ID Head

RO00O1 11.041

RO0O2 5.300

[ TANKS ]

;ID Elevation InitLevel MinLevel MaxLevel Diameter
Teoo1l 46.690 0.34 0.34 3.88 14.03
TO002 53.956 0.20 0.20 3.63 20.55
[PIPES]

14
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;ID Nodel Node2 Length  Diameter Rough-

Pooo1 Jo355 Joe41e 143.90 83.10 131 ;ACC_DN8
P0002 Joo14 Joo13 51.89 163.40 134 ;PEC_DN5
[VALVES]

;ID Nodel Node2 Diameter Type Setting
PRV00O0O1 J1757 J1088 300 PRV 35.594
PRV000O2 J0292 Jo290 110 PRV 32.620
[TAGS]

;Elemento 1ID Tag

LINK Pooo1 ACC

LINK Po002 PEC

[ COORDINA-

;Node X-Coord Y-Coord

Jooo1l 2403792.78 5074946.34

RO0O1 2404079.68 5074684.76

[VERTICES]

;Link X-Coord Y-Coord

Pooo1 2405105.33 5073823.19

P0002 401797.48 5075166.22

[END]

1.2.1.1. [TITLE]. La prima sezione presente in un file .inp contiene un
titolo descrittivo della rete che si vuole analizzare. Una buona abitudine
nella scelta del titolo ¢ quella di indicare la data di realizzazione nel forma-
to: aaaammdd. La sezione T7#e ¢ facoltativa.

1.2.1.2. [OPTIONS). Options ¢ la sezione in cui vengono definite le opzio-
ni di simulazione. Tra queste le principali sono:

*  Units;

* Headloss.

15
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Units permette di settare le unita di misura in cui vengono espressi 1 dati.
Per quanto riguarda le portate, utilizzando solitamente 1 litri al secondo, si
puo impostare LPS (Lizers Per Second). Un altro esempio di unita di misura
che puo essere scelta ¢ CMH (Cubic Meters per Hour), metri cubi al secondo.
Con Headloss si definisce quale formula di resistenza si desidera utilizzare
per calcolare le perdite di carico distribuite lungo le condotte. Si puo sce-
gliere tra:

* la formula di Hazen-Williams (H-W);

* la formula di Darcy-Weisbach (D-W);

* la formula di Chezy-Manning (C-M).
Tali formule utilizzano la seguente forma base:

AHj; = QB (1.1)

dove AHjj ¢ la perdita di carico lungo il tronco dai nodii e j, r; ¢ il coeffi-
ciente di resistenza, Qij ¢ la portata fluente nel tronco, n il suo esponente.
Nella Tabella 1.1 sono riportate, per ognuna delle tre possibilita, le espres-
sioni utilizzate per definire r; e n. Tali espressioni chiamano in causa dei
coefficienti di scabrezza (C, €, n) i quali, a loro volta, devono essere deter-
minati empiricamente. Nella Tabella 1.2 sono elencati alcuni loro valori
tipici in funzione del materiale della condotta, considerando una condizio-
ne di tubi nuovi (non tubi usati).

La formula di Hazen-Williams ¢ applicabile solo per moto turbolento di
transizione (in campo assolutamente turbolento sottostima le perdite di
carico fino al 40%), non richiede iterazioni e permette di ridurre o au-
mentare la resistenza in condotta con una flessibilita tale da renderla idea-
le per la calibrazione di sistemi di distribuzione idrica, dove parte di rete
funziona proprio in regime laminare o si trova in zona critica.

I’equazione di Darcy-Weisbach ¢ la pit completa ed accurata, riproducendo
bene il comportamento del fluido su tutto il campo di moto. Richiede pero
il calcolo iterativo del fattore di attrito f.

La formula di Chezy-Manning, infine, ¢ applicabile per moto turbolento
completamente sviluppato, non richiede iterazioni ed ¢ la maggiormente
utilizzata in fase di progettazione.

16
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Tab. 1.1. Espressioni per definire r; ¢ n e ottenere perdite di carico in ft e portate in '/ s

Headloss 1 n
Hazen-Williams 4.727C(1852) J(48T) ], 1.852
Darcy-Weisbach 0.0252f(e,d,q) d9 L. 2
Chezy-Manning 4.66n2 d539) 1, 2
Note: C=coefficiente di scabrezza di Hazen-Williams
€ =coefficiente di scabrezza di Darcy-Weisbach [1/{t3]
n=coefficiente di scabrezza di Chezy-Manning
f=fattore di attrito (dipende da €,d e q)
d=diametro condotta [ft]

L=lunghezza condotta [ft|
q=portata [ft3/s]

Tab. 1.2. Valor: tipici del coefficiente di scabrezza in funzione del materiale, tubi nuovi.

Materiale Hazen-Williams | Darcy-Weisbach | Chezy-Manning
C[ e [1/£0)] n [

Ghisa 130-140 0.85 0.012-0.015
Cemento 120-140 1.0-10 0.012-0.017
Ferro zincato 120 0.5 0.015-0.017
Plastica 140-150 0.005 0.011-0.015
Acciaio 140-150 0.15 0.015-0.017
Argilla vetrificata 110 0.013-0.015

Nei file .inp atti a realizzare nuovi modelli di simulazione che dovranno
essere poi necessariamente calibrati ¢ opportuno utilizzare la formulazione
di Hazen-Williams.

La sezione Opfions ¢ facoltativa. Tutte le opzioni, se non specificate, as-
sumono impostazioni di default.

1.2.1.3. [JUNCTIONS)]. Junctions ¢ la sezione in cui vengono definiti i nodi
della rete, estremita dei tronchi (sezione obbligatoria).

Ogni riga corrisponde a un nodo e contiene:

* ilsuoID;

* lasua quota;

* lasua Base Demand (facoltativa);

* T'ID del Demand Pattern (facoltativo).

17
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Puo essere utile scegliere di definire 1 nodi con un ID che indichi il tipo
di elemento (J per junction) il Comune in cui si trova geograficamente
(con una sigla di tre lettere per esempio) e un numero identificativo pro-
gressivo.

La Base Demand ¢ la portata media o nominale richiesta al nodo e puo
essere calcolata sulla base delle letture dei contatori delle utenze associate
al nodo. Siccome pero disporre di dati dei contatori delle utenze geo-
riferiti non ¢ ancora una pratica consolidata e gli strumenti che solitamen-
te si hanno a disposizione rendono poco pratico collegare tali informa-
zioni ai nodi di pertinenza, solitamente si procede ad una stima grossola-
na della Base Demand che puo essere ridefinita successivamente.

Tale stima si basa sul valore del fatturato medio dei distretti in cui il si-
stema ¢ suddiviso, fatturato che viene poi distribuito sui nodi secondo la
lunghezza della porzione di rete ad essi associata. Per calcolare tale valore
si svolge semplicemente il prodotto di due fattori:

* il valore del fatturato medio [1/s];

* il rapporto tra la somma delle mezze lunghezze associate al nodo e la
lunghezza totale del distretto (peso adimensionale), dove per somma
delle mezze lunghezze associate al nodo si intende la somma della
meta delle lunghezze di tutti i tronchi della rete che convergono in ta-
le nodo (valore calcolabile attraverso semplici passaggi su Excel a par-
tire dal vettore ‘Intersezione’).

Come controllo deve risultare che la somma delle Base Demand di tutti i

nodi del distretto equivalga il valore del fatturato medio. E importante

precisare che tale stima puo incorrere a una distribuzione delle domande
non coerente con la realta. In particolare, bisogna prestare particolare

attenzione a:

* zone disabitate o con densita abitativa bassa;

* centri urbani densamente abitati o zone con consumi significativi.

Individuate tali aree ¢ bene aumentare o diminuire opportunamente le

Base Demand precedentemente calcolate.

I Demand Pattern, invece, associano alle Base Demand dei nodi un time

pattern, ovvero una serie di moltiplicatori, uno per ogni time step, la cui

media complessiva ¢ unitaria. Tali moltiplicatori permettono la simulazio-
ne della variazione temporale della domanda al nodo. I Demand Pattern
si definiranno successivamente, distretto per distretto.

18
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1.2.14. [RESERVOIRS|. Reservoirs ¢ la sezione in cui vengono definiti 1
punti di captazione della rete (¢ necessario che vi sia almeno un reservoir
o un tank in un modello EPANET di una rete).

Ogni riga corrisponde a un reservoir e contiene:

* ilsuo ID;

* il corrispondente carico piezometrico;

* I'ID dell’Head Pattern (facoltativo).

Come per i nodi, puo essere utile porre un ID che indichi il tipo di ele-
mento (R per reservoir), il Comune in cui il punto di captazione si trova
geograficamente (con una sigla di tre lettere per esempio) e un numero
identificativo progressivo.

11 carico piezometrico dei punti della sorgente o della falda da cui si attin-
ge si determina a partire dalle quote di progetto dell'impianto.

Gli Head Pattern hanno la stessa funzione dei Demand Pattern, asso-
ciando in questo caso al carico piezometrico dei reservoir una serie di
moltiplicatori atti a simulare la variazione temporale del suo valore.

1.2.1.5. [TANKS). Tanks ¢ la sezione in cui vengono definiti i serbatoi

della rete (¢ necessario che vi sia almeno un reservoir o un tank in un

modello EPANET di una rete).

Ogni riga corrisponde a un tank e contiene:

e ilsuo ID;

* la quota di fondo serbatoio;

¢ il livello nel serbatoio all’inizio della simulazione;

* il livello minimo che si puo realizzare nel serbatoio;

* il livello massimo che si puo realizzare nel serbatoio;

¢ il diametro nominale del serbatoio;

* il volume minimo che si puo realizzare nel serbatoio (facoltativo);

* TID della curva dei volumi del serbatoio, quand’esso non ¢ cilindrico
(facoltativo).

I’ID puo essere posto come per le sezioni precedenti, indicando in que-

sto caso il tipo di elemento con la lettera T.

La quota del fondo vasca, il livello minimo (corrispondente al dispositivo

di presa) e il livello massimo che si puo realizzare nel serbatoio (corri-

spondente allo scarico di superficie) si possono determinare a partire dalle

quote di progetto dell’impianto.
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11 livello del serbatoio all'inizio della simulazione si definisce solo nella
fase finale della realizzazione del modello, una volta scelta la giornata da
simulare (nel frattempo ¢ prassi porlo pari al livello minimo).

Noto il livello massimo del serbatoio e il volume totale dell'invaso, V.,
determinato a partire dalle caratteristiche geometriche del serbatoio, ¢
possibile calcolare il diametro nominale del serbatoio:

Vtot

Dy = (1.2)

Al

lmax

Infine, nel caso in cui il serbatoio abbia una geometria particolare, ¢ pos-
sibile inserire per punti la curva che mette in relazione la quota pelo libero
e il volume invasato (curva dei volumi).

1.2.1.6. [PIPES)]. Pipes ¢ la sezione in cui vengono definiti i tronchi della
rete, compresi tra due nodi (sezione obbligatoria).

Ogni riga corrisponde a un tronco e contiene:

e il suo ID;

¢ TID del nodo iniziale;

e JID del nodo finale;

* lasualunghezza;

* il suo diametro;

* il suo coefficiente di scabrezza;

* il coefficiente delle perdite localizzate (facoltativo);

* il suo status (facoltativo).

Nell'ID per indicare il tipo di elemento si puo utilizzare la lettera P.

Gli ID dei nodi iniziale e finale si possono recuperare dal layer ‘Link’,
come anche la lunghezza dei tronchi.

I diametri delle condotte ¢ necessario potli pari ai loro reali diametri in-
terni. A partire dai diametri nominali del layer ‘Link> (DN), ¢ possibile
definire il diametro interno in funzione al materiale di cui € costituita la
condotta (Oppo, s.d.).

I coefficienti di scabrezza (C per la formula di H-W) sono uno dei para-
metri principali di calibrazione. Essi possono essere posti in prima battuta
dipendenti dal solo materiale costituente. Un esempio di valori di primo
tentativo ¢ il seguente:
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* Cparia 131 per tubazioni in acciaio;

* Cparia 132 per condotte in ghisa grigia o in ghisa sferoidale;

* C paria 133 per tubazioni in fibrocemento;

* C pari a 134 per condotte in materiali plastici (polietilene, cloruro di
polivinile, PEAD, ecc.).

Durante la taratura tale valore potra essere cambiato, sia mantenendo la

distinzione riguardo ai materiali sia variandolo tra condotte composte

dallo stesso materiale ma che possono presentare scabrezze maggiori per

eta o per effetto della corrosione.

In EPANET, inoltre, vi ¢ la possibilita di simulare anche le perdite loca-

lizzate, per esempio dovute a valvole o a curvature significative del trac-

ciato planimetrico della rete. Tali perdite vengono calcolate con la seguen-

te formula:

AH, =K (‘2/—;> =

dove K ¢ il coefficiente delle perdite localizzate, v ¢ la velocita dell’acqua
e g laccelerazione di gravita. Il coefficiente delle perdite localizzate puo
essere determinato empiricamente e definito nella presente sezione. Se
non specificato, viene assunto pari a zero, ovvero non vengono conside-
rate le perdite localizzate — condizione maggiormente utilizzata (lunghe
condotte).

Lo status permette di definire se una condotta ¢ aperta o chiusa. Se non
specificato viene assunto OPEN.

Si noti come, nell’estratto del file .inp riportato ad esempio, alla fine di
ogni riga della sezione Pipes sia presente il ¢’ seguito da una sigla che
specifica il materiale e dal valore del diametro nominale. Tale stringa verra
visualizzata come Description dell’elemento su EPANET.

1.2.1.7. [VALVES]. Valpes ¢ 1a sezione in cui vengono definite le valvole
presenti nella rete. Le valvole di distretto, nello specifico, verranno invece
prese in considerazione successivamente.

Ogni riga corrisponde a una valvola e contiene:

¢ ilsuoID;

e TP'ID del nodo iniziale;

e JID del nodo finale;
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* il suo diametro;

* il tipo di valvola;

* il parametro descrittivo del punto di funzionamento;

* il coefficiente delle perdite localizzate (facoltativo).

Nell’ID ¢ utile indicare il tipo di valvola (per esempio PRV per le valvole

riduttrici di pressione) oltre al Comune associato e al numero identificativo

progressivo.

In EPANET si possono simulare sei tipi di valvole:

* la PRV (Pressure Reducing 1 alve) valvola che riduce la pressione a valle
dello strumento;

* la PSV (Pressure Sustaining 1 alve) valvola che mantiene la pressione a
monte dello strumento;

* la PBV (Pressure Breaker 1 alve) valvola che simula una rottura di carico;

* la FCV (Flow Control Valve) valvola che controlla la portata a valle
dello strumento;

* 1aTCV (Throttle Control 1/ alve) valvola che simula una perdita di carico;

* la GPV (General Purpose Valve) valvola generica che permette per
esempio di simulare turbine.

Mentre nei shapefile le valvole solitamente sono rappresentate come ele-

menti puntuali, in EPANET vengono modellate come dei link. Percio ¢

necessario visualizzare su QGIS il tronco associato ad ogni valvola, pren-

derne nota e, una volta eliminato dalla sezione Links, inserirlo in questa

sezione mantenendo I'ID dei nodi iniziale e finale e il diametro nominale

ad esso associati.

Ad ogni tipo di valvola, inoltre, corrisponde un differente parametro

descrittivo del punto di funzionamento. Per la PRV, la PSV o a PBV si

specifica un valore di pressione, per la FCV si specifica un valore di por-

tata, per la TCV il valore del coefficiente di perdita localizzata e per la

GPV si specifica 'ID della curva portata-perdita di carico.

1.2.1.8. [TAGS]. In questa sezione ¢ possibile associare ad ogni elemento,
specificandone la tipologia e I'ID identificativo, un tag ovvero una stringa
che descriva Pappartenenza dello stesso a una qualche categoria.

Ai link ¢ funzionale applicare un tag identificativo del materiale di cui
sono composti, per permettere durante la calibrazione una facile variazio-
ne del coefficiente di scabrezza in funzione del materiale delle condotte.
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Al nodi invece ¢ pratico associare un tag identificativo del distretto di
appartenenza, funzionale alla fase di taratura del modello.

1.2.1.9. [COORDINATES]. Coordinates ¢ la sezione in cui si assegnano a
tutti gli elementi puntuali (nodi, reservoir, tank) le loro coordinate spaziali
X ey, recuperate dai rispettivi layer.

1.2.1.10. [IVERTICES). In questa sezione vengono definiti in successione i
vertici dei tronchi della rete, ovvero i punti che li descrivono nel loro svi-
luppo planimetrico tra il nodo iniziale e il nodo finale. Essi vengono definiti
specificando I'ID del Pipe di appartenenza e le loro coordinate x e y.

E importante prestare attenzione al fatto che QGIS nel creare il vettore
“Vertici’ (paragrafo §1.1.2) ha inserito anche 1 nodi di estremita. Per cui il
foglio di calcolo contenente i dati di tale layer, prima di essere utilizzato
per 'impostazione della suddetta sezione, deve essere ‘pulito’ dai vertici
coincidenti con i nodi, pena la generazione di errori durante
I'elaborazione del modello su EPANET.

1.2.1.11. [END). End ¢ la sezione che definisce il termine del file di input.

1.3. Completamento del modello di simulazione attraverso EPANET

Una volta predisposti su Excel i dati estratti da QGIS secondo
I'impostazione appena descritta, si procede semplicemente copiandoli su
un file .txt che EPANET riconoscera come file di input; aprendolo infatti
dal software EPANET ¢ possibile visualizzare la rete con i dati e le pro-
prieta finora specificati.

A questo punto si prosegue inserendo le ultime informazioni necessarie a
completare il modello di simulazione, informazioni che possono essere
inserite anche attraverso il file di input ma che risulta piu pratico inserire
direttamente in EPANET.

1.3.1. Integrazioni finali
1.3.1.1. Pompe. Prima di inserire letteralmente gli elementi pump nel mo-
dello ¢ necessario indagare se pompe di uno stesso impianto di pressuriz-

zazione lavorino o meno in sinergia. In caso affermativo per ogni pompa
bisognera creare un elemento distinto, se invece all'interno del medesimo
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impianto ¢ attiva un’unica pompa alla volta, I'intero impianto ¢ schema-
tizzabile su EPANET con un unico elemento.

Inserite quindi le pompe si prosegue definendone le curve caratteristiche,
partendo dalle carte tecniche degli impianti e dalle informazioni in esse
contenute. All'interno della finestra Browser > Data di EPANET acceden-
do alla sezione Curves ¢ possibile definire delle curve di relazione tra due
grandezze a partire da coppie di dati forniti. Tra le varie curve che si pos-
sono definire vi sono anche le curve caratteristiche delle pompe che met-
tono in relazione la portata e la prevalenza delle stesse (Curve Type >
PUMP). Tali curve possono avere diverse forme in base al numero di
coppie di dati fornite al software, nello specifico se si possiede una sola
coppia di dati, tre coppie di dati, o pit coppie di dati. Nei primi due casi
EPANET crea delle spline passanti per i punti di misura nel piano porta-
ta-prevalenza, nell’'ultimo caso crea direttamente una spezzata.

Infine, se I'impianto di pressurizzazione ¢ direttamente collegato ad un
serbatoio e il suo funzionamento dipende dal livello dello stesso, ¢ neces-
sario procedere con un’analisi incrociata tra i dati riguardanti lo stato delle
pompe e 1 dati sulla variazione del livello allinterno della vasca per ricer-
care la corrispondenza stato pompe-livello serbatoio. Grazie alla sezione
Controls della finestra Browser > Data di EPANET ¢ possibile esprimere
questi settaggi attraverso proposizioni logiche, semplici o composte, che
legano valori di parametri di elementi diversi.

1.3.1.2. Chiusure. Per chiusure si intendono le valvole di distretto della rete,
ovvero le saracinesche chiuse che fisicamente delimitano i distretti. Esse
non vengono rappresentate da elementi valves bensi le si mantengono
come link. I.’operazione da svolgere in questo caso consiste nell’identificare
sul programma QGIS il tronco loro associato e, selezionato I'elemento pipe
su EPANET, variarne lo status da open a closed.

1.3.1.3. Galleggiante. Mentre nei serbatoi alimentati direttamente dagli im-
pianti di pressurizzazione il livello puo essere regolato con la programma-
zione delle pompe, nei serbatoi ad alimentazione diretta (per esempio da
sorgente) e nei serbatoi ‘secondari’ il livello viene regolato necessariamen-
te da un apposito dispositivo, il galleggiante.

Man mano che il livello della vasca cresce, tale dispositivo riduce la sezio-
ne utile della condotta di alimentazione, chiudendola completamente
quando il serbatoio raggiunge un livello prestabilito. Tale meccanismo
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puo essere simulato in EPANET ponendo subito a monte del serbatoio
(nella condotta di alimentazione) una valvola PRV, attribuendo ai suoi
nodi di estremita quota pari alla quota del serbatoio (quota fondo vasca) e
come setting il livello massimo a cui il galleggiante chiude fisicamente la
condotta.

1.3.2. Impostazione della simulazione. Le ultime informazioni mancanti
per completare il modello di simulazione dipendono dalle misure che
verranno utilizzate successivamente per la sua calibrazione, operazione
necessaria affinché il modello sia attendibile.

1.3.2.1. Calibration Data. Funzionale alla calibrazione del modello sono i
dati di calibrazione, dati di misure realmente registrate in punti definiti

della rete che la simulazione deve avvicinare il piu possibile.

Fig. 1.5. Esempio di impostazione di file .1xt per importare i dati di calibrazione.

7| Esempio - Blocco note di Windows - O X
File Modifica Formato Visualizza ?
;Location Time Value A
P_1172 @©:01 49.94

0:07 50.21

0:13 50.35

0:19 50.07

9:25 50.21

0:31 50.75

0:37 50.35

0:43 49.26

0:49 49.40

0:55 50.35

1:01 9.38

1:07 0.38

i i 12 0.38

1:19 0.38

1:25 0.38

1:31 0.38

i B2 74 0.38

1:43 0.38

1:49 0.38

55 0.38

2:01 0.38

2:07 0.38

2238 0.38

2:19 9,38 Y
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Tali dati sono:

* misure di portata, registrate dai misuratori fissi solitamente posti sulle
condotte a confine tra i distretti, uniche condotte attraverso le quali i
distretti sono alimentati o alimentano altri distretti, e sulle condotte in
uscita dai serbatoi e dagli impianti di pressurizzazione presenti;

* misure di pressione, registrate se possibile negli stessi punti in cui si
misura la portata;

* misure di livello dei serbatoi presenti nel sistema, da importare su
EPANET come carico totale sommandole alla quota del fondo vasca.
Raccolte tali misure, analizzata la loro consistenza ed attendibilita (‘vuot?’
nelle registrazioni o errori sistematici), scelta una data di riferimento per il
processo di taratura, si procede con la loro importazione. Per far cio ¢
necessario creare un file .txt per ogni grandezza in cui copiare le misure
registrate precedute dall’ID dell’elemento del modello associato: nodes
per le misure di pressione, links per le misure di portata e tanks per le
misure di carico totale (Fig. 1.5). I file di testo si caricano quindi su
EPANET selezionando sulla barra dei menu Project > Calibration Data. .. e
inserendo il percorso del file corrispondente ad ogni grandezza misurato.

1.3.2.2. Opzioni di simulazione e condigioni inigiali. Nel realizzare un modello
di rete su EPANET ¢ indispensabile impostare correttamente le opzioni
di simulazione e definire le condizioni iniziali del sistema.

Nella finestra Browser > Data accedendo alla sezione Options ¢ possibile
definire, sotto la voce Times, la durata della simulazione (solitamente gior-
naliera, 24 h) e la durata dei time step, in base alla frequenza di campio-
namento dei dati di calibrazione o piu generalmente in base al dettaglio
con cui si desidera simulare 'andamento temporale delle portate e delle
pressioni (solitamente non superiore all’ora).

E necessario inoltre reimpostare gli Initial Level dei serbatoi con il primo
valore realmente misurato durante la giornata scelta per la calibrazione e
controllare che i Fixed Status delle PRV e gli Initial Status delle pompe
siano impostati coerentemente con il loro reale stato all’inizio della gior-
nata scelta.

1.3.2.3. Demand Pattern. A questo punto l'ultimo passo, prima di prosegui-
re con una prima simulazione, riguarda la definizione dei pattern.

Come descritto al paragrafo §1.2.1.3 per simulare la variazione temporale
delle domande ai nodi si devono definire i cosiddetti time pattern, ovvero
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una serie di moltiplicatori, uno per ogni time step, la cui media comples-
siva ¢ unitaria, che verranno applicati alla Base Demand dei nodi.

Per calcolare tali moltiplicatori, scelta la data su cui svolgere la taratura, ¢
necessario preliminarmente calcolare 1 bilanci idrici dei distretti ovvero i
bilanci tra portate entranti e portate uscenti misurate.

Per ogni distretto si procede con il calcolo della portata media circolante
ad ogni time step. Il valore cosi ottenuto puo essere rapportato alle perdi-
te idriche e al fatturato del modo seguente (Fig. 1.6):

Quoe(® = D L +p"(OKQy (1.4)

Nell’espressione appena riportata:

* Q. (t) ¢la portata media calcolata, circolante nel distretto al tempo t;

* Q, ¢l fatturato medio del distretto, calcolato a partire dalle letture dei
contatori delle utenze del distretto, riferito a un periodo ‘strategico’
(periodo estivo, periodo invernale) o a un anno di fatturazione;

* 1(t) sono le perdite reali che si verificano nelle diverse condotte i al
tempo t, la cui somma puo essere rapportata al fatturato medio con la
relazione:

DL =k-Qy +2®) 1.5)

dove g(t) ha dimensione di portata e media giornaliera nulla;
* p"(t) ¢ il moltiplicatore che va a comporre il time pattern del distretto
(media giornaliera unitaria);
* e il coefficiente con cui si tiene conto della stagionalita, delle perdite
apparenti e dei consumi autorizzati non fatturati.
Per la stima di ogni contributo dell’equazione (1.4) si puo procedere nel
modo seguente.
Si calcola Q. ., media giornaliera di Q,,(t), e la differenza tra essa e il
MNF (Minimum Night Flow): AQ=Q,,,-min[Q,,(t)].
Se AQ<Q), allora si considera che il consumo antropico notturno sia pari
alla differenza (Q,-AQ) e W si suppone unitario. Se invece AQ>Q), allora
si considera che il MNF venga completamente perso (minimo consumo
antropico nullo) e si stima p ponendo AQ=pQ,.
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Fig. 1.6. Grafico di un bilancio di distretto e delle diverse componenti.

Qtot,m

=
26

Noti Qy, Qoum € W, € possibile calcolare le perdite reali medie del distretto:
media [z ]; (t)‘ =Kk Qb = Qtotm — MQp (1.6)
i

A questo punto, assumendo che le perdite siano costanti nel tempo
(e()=0), ¢ possibile definire per ogni distretto il rispettivo time pattern
che ad ogni time step fa corrispondere il parametro:

_ Qtot(t) -k Qb (1.7)

P HQpb

LLa serie di moltiplicatori cosi calcolata per ogni distretto si puo inserire in
EPANET dalla finestra Browser > Data accedendo alla sezione Patterns.
Per applicarli infine al modello attraverso Edit >Group Edit... ¢ possibile
selezionare tutti i nodi appartenenti a uno stesso distretto (grazie al tag
definito) ed assegnargli il rispettivo Demand Pattern.
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2. CALIBRAZIONE DI UN MODELLO EPANET

I presente capitolo riporta i passaggi fondamentali per una corretta cali-
brazione dei modelli di simulazione di sistemi acquedottistici.

2.1. Impostazione del modello

Prima di trattare gli aspetti prettamente inerenti alla simulazione e alla
calibrazione attraverso EPANET si ritiene necessario fare alcune pre-
messe.

Spesso la calibrazione dei modelli EPANET ¢ una procedura che viene
svolta o commissionata a posteriori rispetto alla condizione reale del si-
stema acquedottistico che si vuole simulare e alle misure raccolte dalla
rete che si vogliono ‘avvicinare’. Cio avviene poiché non vi sono proce-
dure definite riguardo alla calibrazione dei modelli che ne definiscano un
livello di precisione minima da raggiungere e una periodicita prestabilita.
Perché ci si possa ‘fidare’ maggiormente dei risultati forniti dai modelli ¢
essenziale non solo che siano ben calibrati ma che tale procedura venga
pianificata con una certa periodicita. E grazie a una programmazione del
processo di taratura che ¢ possibile impostare il modello nella maniera piu
corretta ed ottenere un risultato di calibrazione ottimale.

Per questo motivo si ¢ deciso di riportare di seguito 1 passaggi da svolgere
preliminarmente alla fase di raccolta dati, simulazione e calibrazione su

EPANET.

2.1.1. Valutazione misuratori e punti di misura strategici alla calibrazione.
Il primo passo per impostare correttamente il modello e ottenere una
simulazione e una calibrazione di qualita ¢ valutare innanzitutto il sistema
esistente di monitoraggio della rete, ovvero stabilire:
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* quanti punti di misura sono in essa previsti, ovvero quanti misuratori
fissi sono presenti e quanti punti sono stati predisposti per il posizio-
namento di misuratori mobili;

* quanti strumenti di portata mobili sono disponibili;

* quali grandezze monitorano, solo portata o anche pressione;

* qual ¢ la precisione nominale ed effettiva degli strumenti;

* qual ¢ laccuratezza strumentale attesa in funzione di un giudizio ri-
guardo all’installazione dei misuratori fissi o ai punti designati al posi-
zionamento dei misuratori mobili.

Penalizzando i misuratori e i punti di misura caratterizzati da un errore di
misurazione atteso maggiore, ¢ necessario ottenere misure affidabili:
* in uscita dagli impianti di pressurizzazione;
* in uscita dai serbatoi di compenso;
* al confine tra i distretti o sub-distretti in cui la rete ¢ suddivisa.
Qualsiasi misura riferita a qualche altro punto della rete ¢ utile nella fase
di calibrazione ma non strettamente necessaria.
E importante precisare che le misure di portata registrate tra i distretti
sono essenziali per calcolare 1 bilanci idrici degli stessi non solo per la
determinazione del Pattern (paragrafo §1.3.2.3) ma soprattutto per calco-
lare le perdite reali attese. Per questo motivo ¢ importante che, qualora
non fosse possibile avere misure riferite a uno stesso periodo di tutti i
punti a confine tra distretti o sub-distretti, siano per lo meno disponibili
le misure di punti che permettano una distrettualizzazione pressoché
omogenea. In altre parole, siccome i distretti si identificano a partire dai
punti di monitoraggio di cui si possiedono effettivamente le misure di
portata, ¢ bene assicurarsi che tali punti permettano di individuare distret-
ti il piu possibile omogenei in termini di estensione della rete racchiusa e
numero di utenze servite.
Una volta definiti i punti di portata da monitorare e da cui raccogliere i
dati di misura e pressione si procede alla scelta del periodo di campiona-
mento. Solitamente si analizzano le misure di una o due settimane del
periodo estivo, periodo piu critico per il sistema. Puo risultare comunque
utile svolgere una campagna di misura e una successiva calibrazione del
modello anche per il periodo invernale, possibilmente quindi creando due
modelli che si riferiscano ai due periodi diversi dell’anno.
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2.1.2. Distribuzione della perdita. Come appena descritto i dati ottenute
dalla campagna di campionamento servono innanzitutto nella fase di
calcolo dei bilanci idrici (paragrafo §1.3.2.3): ¢ con i bilanci idrici che ¢
possibile svolgere una prima stima delle perdite reali che investono i di-
versi distretti, k-Q,.

Per simulare le perdite in EPANET si utilizzano gli emitters, dispositivi
associati ai nodi che modellano lo scarico di flusso a pressione atmosferi-
ca attraverso ugelli o effusori. La portata che fluisce attraverso gli emitters
varia in funzione della pressione secondo I'equazione:

Q= CpY 2.1

dove Q) ¢ la portata, p ¢ la pressione nel nodo in esame, C ¢ il coefficiente
dell’emitter e y ¢ 'esponente della pressione. EPANET considera gli
emitters come una proprieta dei nodi e non come dei componenti distinti
della rete. y, posta solitamente di default pari a 0,5, si definisce nella fine-
stra Browser > Data accedendo alla sezione Options alla voce Hydranlics >
Emitter Exponent, mentre C compare tra le property dei nodi.

Svolta quindi una prima stima delle perdite che si realizzano nei diversi
distretti ¢ possibile calcolare un emitter coefficient di primo tentativo, da
applicare poi ai nodi di ogni distretto come fatto con i Patterns.
Ipotizzando che in ogni distretto la perdita sia distribuita tra i nodi e as-
sumendo che le perdite siano costanti nel tempo (€(t)=0), si puo scrivere

che:
k-Qp= Z = Z Cip{® 2.2)
i i

Ponendo che I'emitter coefficient e la pressione media giornaliera siano
uguali per ogni nodo del distretto si ottiene la seguente relazione:

k-Q
= —e 2.3)
Pp

Cp

dov e Cj, ¢ emitter coefficient di primo tentativo del distretto, k-Q, la perdita

stimata con i bilanci idrici e P, ¢ la pressione media stimata nel distretto attra-
verso una breve analisi del'andamento delle pressioni nello stesso.
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2.1.3. Distribuzione della domanda idrica: diversi possibili approcci. La
domanda idrica richiesta dalle utenze collegate all’acquedotto ¢ un aspetto
molto delicato da trattare nei modelli di simulazione.

Essa in EPANET viene distribuita ai nodi e non lungo i rami della rete

come avviene realmente, ma per rapporti Q /P maggioti a 5, dove Q, ¢ la

portata entrante al ramo e P ¢ la portata totale distribuita sul ramo,

I'erogazione continua si puo ritenere egualmente concentrata ai nodi di

estremita. Per 1 tratti piu lunghi e con densita di allacci non trascurabile ¢

comunque consigliabile procedere alla suddivisione in tronchi intermedi.

11 valore medio della domanda complessiva associata ai nodi viene indica-

ta tra le property dei nodi come Base Demand.

Come gia esposto al paragrafo {1.2.1.3, in assenza di strumenti per asso-

ciare il fatturato delle singole utenze ai nodi di pertinenza, la domanda

idrica di distretto puo essere stimata in maniera grossolana distribuendo il

fatturato medio dei distretti tra i loro nodi secondo un peso basato sulle

lunghezze ad essi associate. Tale stima, come gia specificato, puo portare

a una distribuzione delle domande non coerente con la realta:

* nelle zone con densita abitativa bassa, in cui generalmente gli elementi
pipes hanno una lunghezza elevata, dove la Base Demand stimata sara
superiore alla domanda reale;

* nelle zone in cui si ha un elevata concentrazione di consumi, solita-
mente centri abitati in cui la rete ¢ molto magliata e di conseguenza gli
elementi pipes sono molto ridotti, dove la Base Demand stimata sara
inferiore alla domanda reale.

Individuate tali aree ¢ bene quindi aumentare o diminuire opportunamente
le Base Demand stimate.
E bene precisare che in questi ultimi tempi si stanno diffondendo soft-
ware commerciali di progettazione e simulazione idraulica delle reti che
permettono di importare dati geo-riferiti come quelli delle letture dei
contatori delle utenze e di collegarli al modello. Cosi facendo, utilizzando
criteri di vicinanza, la domanda delle utenze puo essere allocata dapprima
alla condotta di distribuzione adiacente e successivamente al nodo piu
vicino. In questo modo si ha una distribuzione della domanda precisa che
porta la simulazione a livelli di attendibilita molto piu elevati.
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2.2. Simulazione

Impostata la simulazione come descritto al paragrafo §1.3.2 e svolte le
analisi preliminari esposte al paragrafo §2.1, si puo procedere lanciando la
simulazione su EPANET attraverso Project > Run Analysis o attraverso
Iicona a forma di fulmine.

Se Panalisi si ¢ conclusa con successo I'icona in basso a sinistra raffigurante
un rubinetto apparira con acqua corrente e uscira il messaggio ‘Run was
successful’. In questo caso per ogni time step EPANET fornisce la solu-
zione idraulica del sistema. Se invece ’analisi non si ¢ conclusa o si ¢ con-
clusa ma nella risoluzione idraulica si sono riscontrati alcuni problemi usci-
ra lavviso ‘Warning messages were generated. See status Report for de-
tails.” Cliccando su OK si apre la finestra Status Report, a cui ¢ possibile
accedere anche dalla barra dei menu Report > Status.

2.2.1. Status Report: warning e loro possibile risoluzione. Nella finestra
dello Status Report vengono riportati 1 problemi riscontrati dal solutore
sotto forma di warning contenenti un codice errore e una breve descri-
zione identificativa.

Di seguito si analizzano i warning piu comuni e la loro possibile risoluzione,
rimandando al manuale di EPANET (Rossman, 2000) (appendice B) per la
lista completa.

Il warning piu frequente ¢ quello di ‘negative pressure’. In questo caso
bisogna innanzitutto identificare la regione in cui la pressione indicata
dal software ¢ inferiore a zero. Una volta identificato I'insieme di punti
interessati bisogna analizzare le condotte che li alimentano: spesso la
pressione simulata crolla rispetto a quella reale perché condotte a monte
di tali zone sono chiuse o dal diametro erroneamente piu piccolo di quel-
lo reale. Fa eccezione il caso in cui tale pressione negativa si riscontri in
adduzione dove ¢ possibile che si verifichino fenomeni di moto a cana-
letta. Siccome EPANET considera solo il moto in pressione all’interno
delle condotte tale fenomeno, che porta 'acqua a scorrere con moto a
pelo libero per alcuni tratti, viene mutuato dal software con un moto a
pressione negativa.

Un altro warning molto comune e quello di ‘network disconnected” in cui
viene precisata quale zona in particolare si trova sconnessa dal resto della
rete non permettendo di soddisfarne la domanda idrica. Assieme al tipo di
errore viene indicato I'ID dei nodi effettivamente scollegati permettendo
una loro facile individuazione. Questo avviso si presenta spesso quando
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una condotta ¢ erroneamente chiusa o eliminata, quando il meccanismo di
funzionamento di una pompa non ¢ correttamente impostato ed essa,
spenta, isola la zona a valle, o quando una vasca, sempre per un errore di
impostazione della stessa, si svuota e la portata in ingresso non riesce a
compensare la portata richiesta in uscita.

Infine, puo accadere che si presenti il warning ‘system unbalanced’ che
indica che il software non ¢ riuscito a raggiungere la convergenza nella
risoluzione idraulica del sistema. Solitamente la fonte dell’errore sono le
impostazioni di funzionamento delle valvole, delle pompe e i controls. Se
dopo aver ricontrollato tali sezioni il problema persiste si puo provare a
risolverlo aumentando il numero massimo di tentativi impostato per la
risoluzione idraulica o riducendo il livello di accuratezza impostato per il
metodo iterativo di calcolo. Queste due impostazioni si trovano nella
finestra Browser > Data accedendo alla sezione Opftions sotto la voce
Hydraulics rispettivamente come Maximum Trials e Accuracy.

2.3. Calibrazione del modello

Una volta completato un modello e risolti i possibili warning emersi ¢
necessario procedere con la sua calibrazione, ovvero fare in modo che le
portate e le pressioni ottenute siano prossime al vero: piu i valori delle
grandezze incognite ottenuti con la simulazione nei punti di misura si
avvicinano ai dati di calibrazione piu il modello ¢ coerente con la realta.
Di seguito si riportano alcune linee guida per tarare il modello rispetto a
misure in campo di portata, pressione e livello nelle vasche. Tale suddivi-
sione ¢ stata fatta per praticita di esposizione ma all’atto pratico la calibra-
zione di una grandezza piu portare alla variazione dei risultati ottenuti per
le altre grandezze per cui il processo di taratura ¢ un processo del tipo
trial and error in cui si deve agire sulle diverse grandezze in maniera si-
multanea.

2.3.1. Taratura relativa alle portate. Per avvicinare i risultati inerenti alle
misure di portata, si agisce principalmente sull’emitter coefficient dei nodi.
La stima fatta delle perdite reali di ogni distretto e il relativo emitter
coefficient ¢ una stima di primo tentativo basata su importanti semplifi-
cazioni.

Nel caso in cui per un punto di misura la simulazione riporti dei risultati
di portata il cui andamento ¢ simile a quello dei dati di calibrazione ma
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inferiore ad esso di una quantita costante nel tempo (Fig. 2.1), allora ¢
necessario aumentare I'emitter coefficient del distretto di cui tale punto
rappresenta una sezione di ingresso.

Fig. 2.1. Calibrazione relativa alle portate.
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Questa variazione ¢ dovuta al fatto che probabilmente la perdita stimata
del distretto ¢ inferiore a quella reale.

Nel caso in cui invece I'andamento delle portate simulate in un punto ¢
pari al’andamento delle portate registrate ma traslato verso Ialto, allora ¢
necessario ridurre 'emitter coefficient dei nodi del distretto relativo.

Se pero anche I'andamento delle portate fornito da EPANET ¢ diverso
dall’andamento dei dati di misura allora le strade da poter intraprendere
sono due: o si agisce sul pattern del distretto, variando quindi I'andamento
della domanda idrica nel tempo, o si agisce sulla distribuzione della perdita.
Con quest’ultima indicazione si intende il fatto che spesso la perdita calcola-
ta con i bilanci idrici dei distretti non ¢ uniformemente distribuita tra i nodi
ma si concentra in tratte o zone particolari. In questi casi, quindi, ¢ necessa-
rio ricercare in campo possibili perdite localizzate nel distretto che potranno
poi essere applicate nel modello come Base Demand aggiuntive nei nodi
della regione interessata oltre che sottratte dalla perdita distribuita ricalco-
lando P'emitter coefficient di distretto.

2.3.2. Taratura relativa alle pressioni. Per tarare i risultati riguardo le pres-
sioni si agisce sul coefficiente di scabrezza delle condotte.

Le pressioni all’interno della rete dipendono fortemente dalle perdite di
carico che in essa si realizzano. Come visto nel paragrafo §1.2.1.2 la per-
dita di carico all’interno di una condotta dipende dal coefficiente di sca-
brezza del materiale. Il materiale pero con il tempo si degrada, la sua sca-
brezza aumenta portando a un incremento della perdita di carico. 11 valo-
re del coefficiente di scabrezza reale, dunque, spesso ¢ inferiore a quello
posto inizialmente, soprattutto per le condotte in materiali metallici come
acciaio e ghisa.

A questo proposito, oltre a modificare 1 coefficienti di scabrezza dei sin-
goli materiali puo spesso tornare utile variare il valore di C (formula di
Hazen-Williams) di specifici tratti della rete come, per esempio, tratti di
collegamento appena sostituiti o adduzioni particolarmente vetuste.

In alcuni casi particolari (Fig. 2.2) in cui le pressioni simulate nonostante
la variazione del coefficiente di scabrezza non riescono ad avvicinare le
misure si puo essere in presenza di ‘strozzature’ non segnalate: una con-
dotta con particolari incrostazioni o piu semplicemente una saracinesca
non completamente aperta.
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Fig. 2.2. Calibrazione relativa alle pression.
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Se invece la pressione media simulata in un punto di calibrazione eguaglia
quella misurata ma il suo andamento ¢ meno marcato potrebbe esserci un
errore nella dimensione del diametro che probabilmente ¢ di poco infe-
riore a quello posto nel modello.

2.3.3. Taratura relativa ai livelli. Nel caso in cui non si potesse ottenere
valori di portata in uscita dai serbatoi ¢ essenziale avere almeno le misure
in ingresso e la variazione nel tempo del livello in vasca.

In questa situazione il distretto direttamente collegato al serbatoio non
avra le misure necessarie al calcolo dei bilanci idrici. Partendo quindi da
un andamento del tutto generico e arbitrario della portata circolante si
dovranno variare sia il pattern sia Pemitter coefficient del distretto finché
il livello simulato nel serbatoio non approssimi il pitu possibile quello
misurato.

Questo tipo di calibrazione ¢ molto complessa e il risultato che produce
ha una bassa precisione, per questo ¢ fortemente consigliato nella fase
preliminare alla calibrazione (paragrafo §2.1.1) assicurarsi di avere tutti i
dati necessari ad una sua buona riuscita.

Se invece i valori di portata in uscita dai serbatoi sono noti ed ¢ quindi
possibile calcolare il bilancio idrico del distretto afferente, allora per tarate
il modello relativamente ai livelli in vasca anziché agire sul pattern e
sull’emitter coefficient risulta piu vantaggioso ai fini della taratura andare
ad operare sui controls che definiscono la corrispondenza stato pompe-
livello serbatoio (paragrafo §1.3.1.3).
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3. AGGIORNAMENTO DI UN MODELLO EPANET

11 presente capitolo ha lo scopo di riportare una serie di best practices per
una gestione efficiente delle informazioni riguardanti i sistemi acquedotti-
stici e in particolare le informazioni utili e necessarie alla loro corretta
modellazione.

Perché un modello possa essere uno strumento decisionale valido deve
essere il piu coerente possibile alla configurazione reale dell’acquedotto.
Per questo motivo, dopo aver realizzato un modello di simulazione del
sistema e dopo averlo calibrato ¢ necessario mantenerlo aggiornato di
tutte le modifiche che nel tempo vengono apportate al sistema reale e
prevederne una periodica ricalibrazione.

Si tratta di ‘manutenere’ uno strumento gia in possesso dagli Enti Gestori
perché possa rimanere un affidabile supporto nell’analisi del sistema ac-
quedottistico e nelle scelte/variazioni progettuali a cui viene nel tempo
Sottoposto.

3.1. Definizione dei file atti a descrivere il sistema

11 primo passo verso una gestione efficiente delle informazioni riguardanti
1 sistemi acquedottistici ¢ identificare in maniera univoca e chiara i file in
cui queste informazioni vengono riportate. In tal senso risulta utile stilare
un elenco che definisca quali informazioni sono raccolte e in quale file e
formato.

Le informazioni a cui ci si riferisce riguardano per esempio il tracciato
planimetrico della rete e le sue proprieta (DN, materiale, eta, ecc.), i ma-
nufatti e gli strumenti installati su di essa (valvole, saracinesche, misurato-
ri, ecc.), la loro posizione e le loro caratteristiche tecniche.

Al fini dello studio del funzionamento del sistema acquedottistico ¢ es-
senziale avere ben chiare le cosiddette condizioni al contorno. E indi-
spensabile conoscere la suddivisione del sistema in distretti, sapere dove
si trovano nello specifico le saracinesche chiuse che definiscono i confini
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dei distretti e le sezioni aperte attraverso le quali essi vengono alimentati
o alimentano a loro volta altri distretti. E fondamentale conoscere con
precisione il funzionamento dei tratti di adduzione, in particolare la quo-
ta delle sorgenti e la presenza o meno di moti a canaletta. Nei casi di
captazione mediante pozzi o galleria filtrante ¢ necessario conoscere la
quota della falda acquifera a cui si attinge e i meccanismi di funziona-
mento degli impianti di pressurizzazione collegati. Questi ultimi, quando
direttamente collegati a serbatoi di compenso, hanno precisi setting che
determinano I'accensione o lo spegnimento di una o piu pompe contem-
poraneamente in funzione del livello nel serbatoio collegato.

Tali informazioni devono essere raccolte e/o descritte in maniera chiara,
concisa ma esaustiva in file di facile reperibilita. Se il sistema con cui
tutte queste informazioni sono state raccolte risulta di difficile consulta-
zione o vi sono informazioni ridondanti in piu file, ¢ consigliabile inve-
stire tempo e risorse nel cercare di rendere tale sistema piu intuitivo,
coerente ed accessibile a beneficio della sua fruizione da parte dei tecnici
del settore.

Vi sono poi tutta una serie di database generati da sistemi di controllo e
monitoraggio della rete la cui gestione ¢ un tema da trattare separatamen-
te in quanto molto pit complesso. I passaggi chiave da tenere presente
nella ricerca di un sistema ottimale che gestisca tali dati sono certamente
la possibilita di filtrarli e aggregarli ad un livello intermedio tra
I'acquisizione e Pl'archiviazione, e la possibilita in post archiviazione di
visualizzarli ed elaborarli per ottenere informazioni necessarie ai fini della
gestione del sistema acquedottistico.

3.2. Definizione di un iter di aggiornamento

Una volta identificati i file atti a descrivere le caratteristiche dell’acquedotto

¢ fondamentale che essi vengano mantenuti aggiornati.

A tal fine risulterebbe utile che ogni Ente Gestore sviluppasse un pro-

gramma interno di aggiornamento con un iter e una periodicita ben defi-

nita. Tale programma una volta impostato puo e deve essere modificato

nelle modalita e/o nelle tempistiche, qualora presentasse problemi di

esecuzione.

In un processo generale di aggiornamento le fasi principali sono tre:

* la ricezione della avvenuta modifica della rete o dei manufatti e/o
strumenti ad essa connessi, in una loro qualche caratteristica;
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* la registrazione dell'informazione;
* Tapplicazione di tale modifica anche allinterno dei file atti a descrive-
re il sistema.

3.2.1. Ricezione della modifica. L.a prima fase ¢ la pitt complicata da stan-

dardizzare. Per modifica della rete si intende:

* quando viene realizzato un nuovo tratto di rete o viene dismesso o ne
viene modificata una qualche caratteristica, per esempio una sostitu-
zione di una condotta con un diametro o materiale diverso;

* quando viene realizzato un nuovo pozzetto o viene dismesso o viene
modificata la sua configurazione, per esempio viene aggiunto o ti-
mosso un collegamento tra condotte o installato un nuovo dispositivo
al suo interno;

* quando una saracinesca viene aperta o chiusa modificando le condi-
zioni al contorno dell’acquedotto;

* quando vengono apportate delle modifiche alle specifiche di serbatoi,
pompe e/o valvole.

In ognuno di questi casi la modifica al sistema deve essere registrata
dall’ufficio tecnico che ha disposto tale modifica.
Poniamo invece che un operatore in campo abbia a disposizione la pla-
nimetria della rete e si accorga che una condotta indicata in planimetria in
realta sia stata dismessa o che una saracinesca indicata aperta sia in realta
chiusa. Anche questo tipo di informazione deve essere recepito e registra-
to dall’ufficio tecnico perché comporta una modifica ai file che descrivo-
no il sistema. L’identificazione di una incongruenza tra il reale stato del
sistema e come esso ¢ stato rappresentato e descritto rientra in questa
prima fase di aggiornamento ed ¢ quindi opportuno standardizzare tale
processo.
Innanzitutto, ¢ bene che il supporto utilizzato dagli operatori sul campo
sia il medesimo e che soprattutto sia il piu frequentemente possibile ag-
glornato: in caso contrario gli operatori si troverebbero a segnalare piu
volte una stessa incongruenza tra cio che osservano in campo e cio che
viene riportato nei supporti che utilizzano. In secondo luogo, ¢ essenziale
che, una volta identificata Iincongruenza, essa venga metodicamente
comunicata all’'ufficio tecnico che avra il compito di registrare tale infor-
mazione.
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3.2.2. Registrazione della modifica. I’annotazione delle modifiche da ap-
portare ai file che descrivono il sistema acquedottistico deve avvenire in
maniera sistematica all'interno di file appositamente creati ed impostati.
Tali file ¢ utile impostarli come un elenco in cui si riporta:

* la modifica da applicare;

* Toggetto della modifica (I'identificativo del pozzetto, la via della con-
dotta interessata, ecc.);

* i file che dovranno essere aggiornati;

* la fonte da cui deriva I'informazione, come per esempio il progetto
che porta alla modifica di un tratto di rete o I'operatore che ha co-
municato 'incongruenza tra stato di fatto e la sua rappresentazione
digitale;

* la data di applicazione di tale modifica sui file interessati, campo da con-
trassegnare nel caso in cui la modifica non sia ancora stata applicata.

Questo elenco, facilmente impostabile su un semplice foglio di calcolo,

risulta utile non solo per tener traccia delle progressive modifiche che il

sistema acquedottistico subisce e per registrare la progressiva verifica sul

campo della verosimiglianza della rappresentazione digitale realizzata
negli anni, ma anche per la terza fase del processo di aggiornamento.

3.2.3. Applicazione della modifica. L’ultima fase del processo di aggior-
namento ¢ la piu delicata e consiste nell’applicare sui file atti a descrivere
il sistema acquedottistico le modifiche precedentemente recepite e regi-
strate.

Nella standardizzazione di questa fase ¢ importante valutare il tempo
impiegato per P'aggiornamento: se le modifiche venissero svolte subito
dopo averle registrate il tempo impiegato, sarebbe sicuramente inferiore a
quello che si impiegherebbe se tali modifiche venissero annotate ed ac-
cumulate per essere applicate tutte assieme solo saltuariamente. Bisogna
quindi individuare una periodicita che possa conciliare il tempo a disposi-
zione dei tecnici del settore con I'esigenza di un aggiornamento costante.
La realizzazione di un file in cui annotare le modifiche durante la seconda
fase ¢ sicuramente di aiuto poiché, aperto tale registro, bisogna solo prestare
attenzione a quali file vanno modificati: spesso puo accadere che la modifica
di un file porti a dover modificare a catena altri file. Una volta svolto
l'aggiornamento, risulta infine utile indicare la data in cui viene eseguito.
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3.3. Aggiornamento del file EPANET

Tra 1 diversi file atti a descrivere il funzionamento di un sistema acque-
dottistico vi sara sicuramente un modello di simulazione. Qualora pero si
fosse in presenza di un file EPANET non aggiornato o il cui aggiorna-
mento non ¢ stato metodico bensi irregolare, prima di applicare iter di
aggiornamento descritto nel paragrafo precedente, bisogna assicurarsi che
tale file sia per lo meno coerente con tutti gli altri file che riportano sul
piano digitale le caratteristiche del sistema acquedottistico.

Di seguito si riportano le sezioni a cui bisogna portare particolare atten-
zione in questo processo.

3.3.1. Aggiornamento del tracciato. I.’aggiornamento piu impegnativo in
termini di tempo riguarda I'aggiornamento del tracciato della rete. Aperti i
file in cui viene rappresentata la planimetria dell’acquedotto in opportuno
sistema di riferimento (assumiamo per esempio sia un CAD), si passa al
setaccio ogni zona di ogni distretto:
* modificando diametri e/o materiale se il modello EPANET riporta
attributi diversi da quelle presenti nel file CAD;
* climinando i tratti presenti in EPANET ma indicati dismessi si CAD;
* aggiungendo le condotte assenti su EPANET ma presenti su CAD.
In particolare, per quanto riguarda i diametri e i materiali bisogna ricorda-
re che in EPANET i materiali vengono identificati attraverso la scabrezza
delle condotte mentre i diametri vengono posti pari ai diametri interni il

cui valore dipende sia dal DN sia dal tipo di materiale di cui ¢ composta
la condotta (paragrafo §1.2.1.6).

3.3.2. Aggiornamento delle condizioni al contorno del sistema. Perché la

simulazione ottenuta attraverso il file EPANET sia attendibile ¢ essenzia-

le che le cosiddette condizioni al contorno siano aggiornate o comunque
coerenti con 1 file in cui vengono definite.

Per condizioni al contorno ci si riferisce a:

* la suddivisione del sistema in distretti, ovvero la collocazione delle
valvole di distretto (saracinesche chiuse che definiscono i confini dei
distretti) e dei misuratori in corrispondenza delle sezioni aperte attra-
verso le quali i distretti vengono alimentati;

* la quota delle sorgenti e, per le captazioni mediante pozzi, la quota
della falda acquifera a cui si attinge;
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* le caratteristiche geometriche dei serbatoi;

* le caratteristiche tecniche degli impianti di pressurizzazione e i loro
settaggl, in particolare quando direttamente collegati a serbatoi di
compenso e il loro funzionamento dipenda dal livello in vasca;

* le caratteristiche tecniche delle valvole installate nella rete e il loro
stato (attive, completamente aperte o completamente chiuse).

3.3.3. Ulteriori possibili aggiornamenti. Risulta sempre piu utile dotare il
proprio modello di simulazione di un livello di dettaglio sempre piu eleva-
to. A tal fine in una fase di aggiornamento ‘a tappeto’ di questo tipo risul-
ta giovevole inserire, se non ancora presenti, tutti i manufatti installati
sulla rete e in particolare tutte le saracinesche e le valvole site nei pozzetti
distribuiti su tutto il sistema.

Disporre infatti di tali elementi nel modello permette, per esempio, qualo-
ra si dovesse isolare un’area specifica per manutenzione, di identificare
quale configurazione di chiusure porta il sistema a garantire gli standard
minimi di servizio nella zona immediatamente esterna a quella isolata.
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4. CONCLUSIONI

Nel presente testo si sono affrontati i temi chiave per una gestione effica-
ce dei modelli di simulazione di dettaglio dei sistemi acquedottistici.
Possedere per ogni rete esistente un suo modello numerico correttamente
impostato, programmarne una calibrazione e un aggiornamento periodico
sono aspetti spesso trascurati o messi in secondo piano all’interno della
pianificazione e gestione globale di tali infrastrutture. Prestandovi pero la
giusta attenzione, investendo inizialmente tempo e risorse, il campo della
modellazione e della relativa gestione porta inevitabilmente a significativi
miglioramenti in termini di gestione del sistema, facilitando la pianifica-
zione o ripianificazione della configurazione della rete e 'analisi della
risposta del sistema a particolari modifiche o condizioni di emergenza,
rendendo 1 modelli degli strumenti sempre piu attendibili e indispensabili.
Il volume B1 ha come oggetto la gestione dei modelli di dettaglio che
pero servono come punto di partenza per la modellazione piu ad ampio
raggio che richiede il Master Plan. Definire degli standard affinché la ge-
stione deti file di modellazione acquedottistica li renda sempre piu coeren-
ti al reale funzionamento dei sistemi ¢ un passaggio fondamentale per
supportare e analizzare le alternative che derivano dal Master Plan.






BIBLIOGRAFIA

*  Oppo. (s.d.). Tratto il giorno 15 maggio 2020 da
https://www.oppo.it/tabelle/diametri_interni_tubi.htm

* Rossman L.A. (2000). EPANET 2 USERS MANUAL. EPA United
States Environmental Protection Agency.






I Quaderni AUSIR, nati da una convergenza di idee di Massimo Ca-
nali, Marcello Del Ben, Daniele Goi e Lorenzo Tosolini, rappresenta-
no una forma di divulgazione dei lavori realizzati in collaborazione tra
I’Universita degli Studi di Udine e I’Autorita Unica per i Servizi Idrici e
i Rifiuti della Regione Autonoma Friuli Venezia Giulia, sui temi della ri-
sorsa acqua e dei rifiuti. Essi riportano attivita di innovazione e ricerca
su tematiche relative a: captazione (A), trattamento-distribuzione (B),
utilizzo-scarico (C), depurazione (D), recupero-reimmissione in ambien-
te (E) della risorsa idrica. Vi sono compresi anche altri temi come: la
comunicazione (¢), gli aspetti economico-giuridici (€) e di gestione (@)
relativi all’articolato mondo dell’acqua, dei rifiuti € non solo.

| contributi includono vari livelli di impegno: parti dei lavori di tesi degli
studenti di vari corsi di laurea, sintesi descrittive di risultati ottenuti in
borse di ricerca, relazioni di assegni di ricerca annuali o pluriennali,
studi svolti in percorsi di dottorato di ricerca, descrizioni dei risultati
raggiunti in ricerche approfondite e pubblicate in giornali dedicati di
livello nazionale e internazionale.

Silvia Battigelli € laureata magistrale in Ingegneria per I’Ambiente e il Territo-
rio, borsista di ricerca presso il Dipartimento Politecnico di Ingegneria e Archi-
tettura (DPIA) dell’Universita degli Studi di Udine.

ISBN 978-88-3283-287-

7888327832877






